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Introduction
Word processing was one of the first popular applications for the 
modern personal computer. In the early days, it provided little 
more than the ability to enter and change text on the screen. 
Today, many more people have computers at home and in the 
office, and virtually all of these use a Word Processor regularly. 
As the years have passed, the capabilities of the computer and its 
software have dramatically increased, far beyond the expectations 
of the first generation of users back in the 1970s and 80s.

Almost since the beginning, Microsoft Word has been 
acknowledged as a leader in its field. It is one of the best selling 
software applications in any category. It grew in complexity, from 
a program with a handful of menu commands, to the sometimes 
bewildering array of features we see today.

In creating Word 2010, Microsoft have logically built on the 
foundation of the previous version. Rather than relying on 
complex menus, Word 2010 works with tabbed visual controls 
that reconfigure themselves to suit what you are currently doing.  
Accordingly, this book works as a graphical teaching guide – 
wherever possible, pictures and worked examples are used to 
demonstrate the concepts covered. It’s not intended to replace 
Microsoft’s documentation; instead, you should view it as a way of 
getting up to speed quickly on a wide range of useful techniques.

The full range of Word’s features is covered in this and the 
following chapters – from creating and editing simple text-based 
documents, to tables, graphics and research tools, as well as more 
advanced techniques, such as viewing and editing documents on 
the Web. 

How to use this book
To gain maximum benefit from this book, make sure you are first 
familiar with the Windows operating environment (using the 
mouse, icons, menus, dialog boxes, and so on). There are a number 
of books in the Easy Steps range that can help you here.

It is a good idea to start off by going through Chapters One and 
Two fairly thoroughly, since these introduce basic concepts on 
which later examples depend. Once you’ve done this, you can then 
freely dip into the other chapters as you like. There is a chapter for 
each of the Command Tabs in the Word interface, so this book is 
organized in the same way as Word itself.

It’s very important to 
experiment using your 
own examples – trying 
techniques a few times 
on test documents will 
give you the fluency and 
confidence you’ll need 
when working for real.
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Starting Word 2010
On some computers Word may have been set up with a desktop 
shortcut. If it hasn’t, here’s how to start it up.

l1 Click the Start 
button in the 
bottom left corner 
of the screen

l2 If Microsoft Word 
appears in this 
menu, you can 
select it straight 
away

l3 If it isn’t in the 
menu then click 
All Programs

l4 The menu expands 
to show you a list of 
programs and program 
groups represented by 
small folder icons

l5 Click the Microsoft 
Office folder to 
expand its list of 
programs

l6 The list of Microsoft Office applications you see will 
depend on what has been installed on your computer

l7 Click on the small icon for Microsoft Word

Next to the Word 
icon you may see a 
list of recently-opened 
documents. Clicking on 
one of these will start up 
Word and also open the 
document automatically.

If you right-click on the 
Word icon a pop-up 
menu appears. Choose 
“Pin to Taskbar” or “Pin 
to Start Menu” to make 
it permanently appear 
in the Windows Taskbar, 
or the main part of the 
Start Menu. 
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The Main Screen
Once Word is up and running, you should see the following  
screen – with all the elements illustrated here:

Command 
Tabs

Mini Toolbar

Quick Access 
Toolbar

View IconsStatus Bar

You can resize Word’s window 
in the normal way, by dragging 
on its border (if it’s maximized 
then you’ll need to click the 

 Restore Down button first).

As you can see from the two 
illustrations on this page, 
Word automatically resizes and 
reconfigures its workspace and 
controls to make the best use of 
the space available. If you can’t 
see the icon or control you want, 
simply make the window larger or 
click the  symbol to see what’s 
been hidden.

Don’t worry if your 
screen doesn’t exactly 
match this illustration. 
Word’s display is highly 
customizable and most 
visual elements can 
be switched on or off 
according to your own 
preferences. You will find 
tips on how to do this 
throughout the book.

Document 
Title

Main Page Zoom

Scrollbar
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The Ribbon
Near the top of the screen is the Ribbon, which gives you access 
to most of Word’s controls with a few mouse clicks. It’s divided 
into a number of Tabs, only one of which is active at any one 
time. In the example below, the Home Tab is showing basic text 
editing and formatting features.

l1 Click on the Insert Tab’s title to activate it. You will see 
that it’s subdivided into seven sections

Using different Tabs in the Ribbon

l2 Each section contains groups of related controls. Let your 
mouse hover over one of these to see a brief explanation 
of its function 

In this example, the 
highlighted text changes 
its appearance as the 
controls in the Ribbon 
are used. It is currently 
formatted using the 
style “Subtitle”. As the 
mouse hovers over the 
style “Title” the text 
temporarily changes its 
format to preview this 
style. For more about text 
styles, see Chapter Two.
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l3 Double-click on the currently active Tab to hide 
the Ribbon temporarily. This is useful if you want to 
maximize the amount of screen space available for 
viewing and editing your document 

l4 When the Ribbon is hidden in this way, clicking on a Tab 
heading will temporarily reveal its contents. Double-click 
on a Tab to restore the Ribbon permanently.

l5 Click on the File Tab to see Word’s new Backstage View. 
This lets you save and load documents, print and manage 
files, together with a range of global options and tools.

...cont’d

Each of the main 
Ribbon Tabs has its own 
chapter in this book. The 
Backstage View (File Tab) 
is covered in detail in 
Chapter Ten.
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The Mini Toolbar
Whenever you have some text selected, the Mini Toolbar 
will appear nearby. It gives you immediate access to the most 
commonly used text formatting options.

Bold

Italic

Underline

Font Color

Format Painter

Center on/off

Background Color

Font Size Larger Smaller Decrease/Increase Indent

Using the Mini Toolbar

l1 Type some text and then select it, by dragging across it 
with the mouse

l2 Drag the mouse directly over the selected text, and then 
gradually move upwards. The Mini Toolbar will fade  
into view just above the text (see illustration below). As 
you move up towards the Mini Toolbar, it will become 
more solid

l3 Click on one of the controls within the Mini Toolbar to 
change the appearance of your selected text

If the Mini Toolbar fails 
to appear when you 
hover over selected text 
with your mouse, try 
right-clicking. A pop-up 
context menu will appear 
with the Mini Toolbar 
immediately above.

Some of the Mini 
Toolbar’s controls have 
keyboard shortcuts. For 
example, Bold can be 
set on and off by typing 
Ctrl+B, and Italic with 
Ctrl+I. To find out if a 
control has a shortcut 
simply hover over it with 
the mouse pointer for a 
few moments. There is a 
handy reference table of 
keyboard shortcuts in  
the inside front cover of 
this book.
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The Quick Access Toolbar
The Quick Access Toolbar is the small collection of tools at the 
top of the screen, above the File Tab.

Save Undo Repeat

l1 Click the Customize icon on 
the Quick Access Toolbar and 
select a command, or choose 
More Commands... to see the 
full list

l2 In the dialog that appears, 
select the “Choose commands 
from” value to see a list of Word 
commands

l3 If you want your customizations 
to be global, make sure “For all 
documents” is selected under 
Customize Quick Access 
Toolbar 

Customizing the Quick Access Toolbar

Customize

You can also access this 
dialog by activating the 
File tab (also known 
as Backstage view), 
choosing Options then 
selecting Quick Access 
Toolbar.

If you use the Quick 
Access Toolbar’s Undo 
button, then a Redo 
button becomes 
available. Undo and 
Redo together allow you 
to step backwards and 
forwards through your 
actions.
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In this illustration you 
can see that Quick 
Access Toolbar is the 
highlighted item at the 
left of the dialog. If you 
select the Customize 
Ribbon option directly 
above then you will 
have the opportunity 
to completely redesign 
Word’s layout of 
controls.

l4 Add icons by double-clicking in the left-hand list, or click 
once to select and then choose Add>>

...cont’d

l5 Remove icons by double-clicking in the right-hand list, or 
click once to select and then click on the Remove button

l6 You can control the order in which the icons appear in 
the toolbar. To do this, select a command from the right 
hand list then use the up and down buttons to change its 
position. The top item in the list will appear as the first 
icon at the left of the toolbar

l7 Click OK when done, or Cancel to abandon your 
changes. The Quick Access Toolbar will now show the 
icons you selected

From the Customize Quick Access Toolbar dialog, you can reset 
the Toolbar to its initial state by clicking the Reset button. It’s 
also possible to Import and Export your customizations to a file 
on disk. This might be useful if, for example, you want to migrate 
your customizations to another computer.
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The Status Bar
The Status Bar is the horizontal strip at the bottom of the Word 
screen. It normally shows details of general settings and display 
options, and can be used for adjusting the zoom level.

Customizing the Status Bar

l1 Right-click anywhere on the Status Bar to call up the 
Customize Status Bar menu

l2 All the Status Bar options are listed, along with their 
current values. For example, in this illustration we can 
see that the Vertical Page Position is 3.2 inches – even 
though this is not normally displayed in the Status Bar

l3 Click on a menu item to add 
it to or remove it from the 
Status Bar

l4 Click anywhere other than 
the menu to close it when 
you have finished

Current 
Page

Dictionary

Spelling & 
Grammar 
Check

Page 
Views

Zoom 
Level

Drag here 
to resize 
the main 
window

Number of 
words selected 
/ total number 
of words
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Getting Help

l1 Move your mouse over a command in the Ribbon. After 
a few moments, a Super Tooltip appears, showing you the 
name of the command (useful if it’s displayed only as an 
icon in the Ribbon). You’ll also see an explanation of its 
function

l2 The  icon 
indicates that a 
dialog box will 
open if you click 
on it. If you just 
hover over it 
with the mouse, 
however, the Super 
Tooltip will include 
a preview image of 
the dialog – as in 
this example

l3 For more online information about any of Word’s 
features, press the F1 key, or click on the  icon in the 
top right corner of the screen

l4 You’ll see an explanation of 
the control in question. If your 
mouse was not pointing at any 
controls when you pressed F1, 
then a general searchable Help 
window appears 

If you have an active 
Internet connection 
you can also access 
Microsoft’s online help 
content. If the indicator 
in the lower right corner 
of the Help window is 
set to Offline, then click 
directly on it and select 
“Show content from 
Office.com”. 
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Text Editing
Text editing in Word is no different to other programs, such as 
Notepad, Wordpad, Outlook or PowerPoint. If you’re already 
familiar with the basic skills, then you might want to skip ahead 
to the next section.

Getting Started

l1 Start up Word so that you have a new blank document. 
If Word is already open, then click on the File tab, and 
choose New, then “Blank document” and click Create

l2 Enter some example text, enough for a line or two. Don’t 
worry if you make mistakes, as these will be easy to 
correct later on. Note the flashing vertical line (known as 
the Insertion Point) which indicates where new text will 
appear.

l3 You can easily move the Insertion Point anywhere in your 
text by clicking with the mouse. The arrow keys will also 
let you move up, down, left and right within the existing 
text. Move your Insertion Point so that it is somewhere in 
the middle of your text.

l4 If you type more text now, it will be inserted at your 
current position. To remove text, use the Backspace key to 
delete the character to left of your current position, and 
the Delete key to remove the character to the right.

The words to the right 
of the Insertion Point will 
automatically move along 
to accommodate any text 
you are inserting. 

Word automatically works 
out when to start a new 
line, without breaking 
words. If you want to 
force a new line, to begin 
a new paragraph for 
example, press the Return 
or Enter key.
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Using the arrow keys, 
or a mouse click, allows 
you to reposition your 
Insertion Point anywhere 
within the text. If you 
try to move beyond the 
existing text, you’ll find 
that the Insertion Point 
refuses to move. One 
way around this is to 
move just to the right 
of the last character and 
then add more text.

Don’t be tempted to add 
extra spacing by pressing 
the spacebar many times. 
Although this will work 
to a certain extent, it’s 
not the most flexible way 
of controlling spacing. 
You’ll learn much better 
techniques for this in the 
next chapter.

Selecting Text
Basic Techniques
Selecting text is almost always the first step when formatting or 
editing, so it’s worth knowing all the different techniques.

l1 Click and drag over the text you want to select. This is 
quick and easy for small amounts of text

l2 If the wrong text is highlighted, click anywhere in the 
text editing area to cancel the selection, then try again

l3 Double-click directly on a word to select it. Triple-click 
to select an entire paragraph
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More Advanced Techniques
It’s worth experimenting with these. Once you’ve practised for a 
while, you’ll be able to instinctively choose the best method each 
time you need to select text.

l1 Move your mouse into the left margin area. You can tell 
that you are in the correct area when the cursor turns into 
an arrow pointing to the right instead of to the left

l2 Drag vertically to select whole lines of text

Start dragging 
here

Finish 
dragging here

...cont’d

l3 The easiest way to select larger amounts very precisely is 
to click the mouse at the start of the text

l4 Locate the end of the area, scrolling if necessary

l5 Hold down the Shift key and click. All text between the 
start and end will be selected. If you accidentally clicked 
at the wrong endpoint, simply Shift + click again

Click here

Shift+Click 
here

If you hold down the 
Shift key when clicking in 
the left margin area, the 
current selection will be 
extended up to the point 
where you clicked.

You can quickly select 
all the text in your 
document by clicking on 
the Select option in the 
Editing section of the 
Home Tab, and choosing 
Select All. The keyboard 
shortcut for this is 
Ctrl+A.
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